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Introduction 
 
Not so many years ago, musicians used to spend most of their time either rehearsing 
or writing notes in hand. For a classical composer, separate string, woodwind and 
choir sheets could take more than 60-80% of the working time besides actually 
writing the music! This has all changed for the good. 
 

 
After the first simple note writing programs for the Atari and the Amiga in the 
1980’ies, we have had two generations of music software. The most comprehensive 
music software packages are still British Sibelius of the second generation and 
German Cubase of the first generation. Whereas the first generation concentrated on 
the studio and sequencer side of music production, the second generation, Sibelius, 
Finale and Encore – to mention the three most famous note writing programs – 
specialize in a wide range of advanced note writing features for professional score 
production. 
 
A-Play has its roots in the very first generation of MIDI based note writing software 
in the mid 1980-ies, but our primary goal has always been to provide the user with a 
fast and professional range of note editing and score production facilities. Thus, A-
Play is not a sequencer or a digital studio, but a “word processor” for note writing. 
 

Word Processing in Three Dimensions 
When writing a normal text, the user concentrates on one continuous line of text, wrapped within 
the margins of the screen, but still one, single line. Unfortunately, music is much more complicated, 
as even a small orchestra score has several lines of music (voices) played at the same time, each 
with individual settings of dynamic phrasing, sound, timbre, effects and other peculiarities. The 
three dimensional grid of a score is not easy to compose, neither is it easy to write down. And for 
that reason, one needs to consider the musical tradition of note writing. The history of note writing 
is long and complicated and even the most advanced digital note writing applications still owe their 
existence to a bunch of Greek music philosophers 2,500 years ago. 
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The History of Printed Musical Notation 
The first music theorist was the Greek philosopher Pythagoras. Around 530 B.C., he discovered the 
properties of the scale, i.e. the intervals and lined out a general musical theory, which was to last for 
almost 2,000 years. The first alphabet for writing music down was also invented by the Greeks, but 
only 22 examples have survived the Antiquity. The first modern notes were invented in the late 
1300-ies evolving into the present system in the 1600-ies. Both the notes and the tablature of our 
times have their roots in Baroque music. In the 1900-ies, the chord symbols were added to the 
vocabulary of musical notation and a number of guitar-specific effect signs were designed in the 
1980-ies. 
 

 
Handset Note types (about 1900). Note the holes in the lines and stems! 

 
Printing notes was always a problem. In the old days, monks made beautifully illustrated songbooks 
with the famous square note heads, often in bright colours. In the renaissance, the notes were 
printed but looked rather clumsy compared to the handwritten masterpieces. Later came the most 
elegantly designed notes ever, etched into copperplates, a technique still valid until 30 years ago. 
Unfortunately but inevitably the price of such exquisite notes was exorbitant, and a cheaper method 
was developed in the late 1800-ies using note lead types. But a major problem with this method 
were the note lines, which due to the handset line parts, always had holes in between the parts, 
making the score hard to read. The last attempt of revolutionizing the printed notes came as late as 
the early 1970-ies when a Danish inventor produced notes by making gigantic master notes for 
ultimate sharpness of the print. Only a decade later, two revolutions appeared, making professional 
note print accessible for everyone, the MIDI format and the PostScript printers. 
 

1986: MIDI and PostScript 
1986 saw two major inventions in the printing and music area, the MIDI format and the PostScript 
vector based typography. Without these two techniques, there would have been no note writing 
programs today. 
 
MIDI 
 After decades of synthesizers and drum programming, the instrument makers finally decided in 

1986 to make a common standard for communication between the various brands of electronic 
instruments. The standard MIDI (Musical Instrument Digital Interface) is a communication 
protocol not unlike the ones used on the Internet, only much faster – actually MIDI is one of the 
fastest transfer protocols in the world. The speed is necessary to present the many layers of the 
music at (almost) the same time, as the protocol uses only one channel for each polyphonic 
voice. A chord has to be rendered as a sequence of notes played very swiftly to produce a sound 
of notes seemingly struck at the same time. A normal MIDI system has 16 such channels, 
allowing for rather impressive orchestra imitations. 32 or more channels can be combined in the 
professional studios. 
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PostScript 
 The typesetting company Adobe in USA invented the PostScript fonts and later the PDF format 

in 1986-87. The new fonts were vector based, i.e. based on mathematical algorithms instead of 
physical (analogue) pictures of letters as in the early photo typesetting in the 1960-ies. The 
PostScript fonts made professional typesetting available for all computer users, reducing the 
printing cost with as much as 80-90%. A note font was among the first fonts on the market. 

Symbolic Notes 
 Similar to the vector based fonts MIDI notes are descriptions of sounds, not actual sound waves. 

The MIDI signals control a number of sound generators, which are responsible for the final 
sound output. The possibility of recording music with a decent quality, compared to the old 
synthesizers, that is, makes it much easier to compose and test music, especially classical 
arrangements. 

 

A-Play – 1986 to 2007 
A-Play was one of the first note writing programs in Scandinavia back in the 1980-ies. The original 
versions 1 to 2 were written for DOS; it was long before Windows and graphical interfaces. In spite 
of its “primitive” looks – white notes on low-resolution black and green screens – it had many of 
the features now found in Sibelius and Lily Pond. But during the 1990-ies, NORDISC put the 
innovative software to sleep as we moved further into the musical theatre business. 
 
In 2002, however, we decided to reopen the project. A new feature list was made, and the goal was 
a web based, free program with a full set of professional functions. In 2006, we discovered the free 
GNU software language for music, Lily Pond. This amazing programming language had everything 
a note writing application would ever need, but the user interface was cumbersome hand 
programming. We took up the challenge, and started building a shell to Lily Pond. It took us three 
months to produce a decent menu system, combining the proven interface of A-Play and the top 
notch programming language Lily Pond. The result was a feature rich and stable working 
environment for note writing and education. 
 
 

 
Gitte Lund working with A-Play ver. 1.0 

in NORDISC Music & Text 1987 
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Installation 
 
To use A-Play, you must install LilyPond version 2.6.5. We also recommend a number of carefully 
chosen text editors for Windows and Linux, but any professional text editor will actually do; these 
programs are just suggestions, except for the LilyPond mother program. If you choose JEdit, you 
will have access to another great music tool, the LilyPondTool, which is the perfect companion to A-
Play. See the JEdit plugin for installation instructions. 
 

WINDOWS 
Lily Pond Music Programming Language (Windows 98 to XP) 

 Download the Free Lilypond Program 
 

 
 

Score Editor  
 Download the Free TED Notepad Text Editor (Windows 98 to XP) 

 

MIDI Player 
 Download the Free Noteworthy MIDI Player (Windows 98 to XP) 

 

File Manager 
 Download the Free FileAnt File Manager (Windows 98 to XP) 

 

GNU/LINUX 
The use of the compiler differs from the Windows version, please see the official LilyPond manual. 

Lily Pond Music Programming Language 
 Download the Free LilyPond Program (GNU/Linux any x86) 

 

 
 

Score Editor (Linux, Windows and Other Systems) 
 Download the Free JEdit Text Editor 

 

http://lilypond.org/
http://lilypond.org/web/install/older-versions
http://lilypond.org/
http://jsimlo.sk/notepad/
http://lilypond.org/
http://www.noteworthysoftware.com/player/
http://lilypond.org/
http://www.fileant.com/
http://lilypond.org/
http://lilypond.org/web/install/older-versions
http://lilypond.org/
http://www.jedit.org/index.php?page=download
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The Menu System 
 

 
 
1. The buttons in the Left Menu open the instruction manual, the Music Theory and the 

Basic Piano books. 
 
2. The Top Menu contains the menu pallets: Score, Notes, Format, Tools and Help. 
 
3. The Reading Pan contains the instruction manual/Help, the Music Theory and the 

Basic Piano book. 
 
The menus are Pallets, i.e. yellow boxes called Copy Pads, where you can copy and paste codes 
into the score. Each menu is arranged according to the traditional workflow of a score. The menus 
follow the top down principle, where the larger elements lead to smaller and more detailed elements 
and groups; just like writing a score from the first piano sketches to the final score arrangement. 
 
The workflow is mirrored in the menu pallets like this: 
 
Score  Paper format, titles, global key, meter etc.  

   Number of systems with specific settings of MIDI instruments, clef and 
lyrics/chords.  

   Import/Export of MIDI to and from LilyPond.  

 



  A-Play Instruction Manual 
 

  13 

Notes  The workspace for writing the individual systems before pasting the system contents 
into the score in the editor. All the most common notes, ties, accents, chords etc. are 
present in the notes menu. 

   Bar lines, ties, octaves, repeats and other elements close to the note level. 

 

 
 
Format  Shortcut menus for all common bar and system properties. 

   Transpose. 

   Advanced layout of the score. 

 
Tools  Advanced features: Chord boxes, harmonizing, jazz chords. 

   Advanced rhythms. 

   Education and ancient music. 
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Quick Guides A-Play 
 

 

LILYPOND (WINDOWS VERSION) 
Once LilyPond has been installed, you can see the LilyPond icon on the desktop. The rest of 
LilyPond is normally invisible, except when something is wrong with the score code. 
 
You have the following daily routines with LilyPond: 
 
1. Compiling the Score When you are ready for a test print, you navigate with ALT + TAB to 

the folder of the LilyPond file (filename.ly): 

 - Double-click on the file. A DOS window opens, and the file is converted to MIDI and PDF. 
You can also right-click on the file and select PDF. 

 Note Linux and other operating systems used different methods for compilation. Please consult 
the official LilyPond manual for the LilyPond version, you are using. 

 - PDF Double-click on the PDF to check the contents of the file. 

 - MIDI Open the MIDI file in Noteworthy MIDI player or drag the file into the program. The 
music is played, while the notes are shown on the player’s screen in real time. If you don’t 
have access to the Noteworthy player, use Windows Media Player. Linux users have their 
own players. 

 
2. Automatic Debugging Each time you compile a score, LilyPond checks your score for errors. 

The program is pretty persistent: It is case sensitive, for example,, so if you write \Major, you 
will have an error while compiling the file (should be \major). If you don’t see a popup 
window with errors, the file is approved, although it can still look ugly on screen – the debugger 
has no sense of beauty. 

 
3. Conversion to .PNG and other formats: See later in this manual and in the Score menu, 

Import/Export. 
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TED NOTEPAD OR JEDIT? 
Take a look of the following screenshots; it is really a matter of taste. JEdit is a famous Linux and 
Mac text editor with tons of features and plug-ins. It also runs under Windows. TED Notepad is a 
very small text editor that resembles the Microsoft notepad. But beneath its simple surface, it has a 
full range of useful editing tools. 
 

TED Notepad 

 
 
TED Notepad counts lines and rows, which is necessary when finding errors. TED Notepad can be 
opened in several new instances, which is very practical when writing music in A-Play. 
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JEdit with the LilyPondTool Plug-in 
 

 
 
The LilyPondTool is a great toolbox including a piano to insert notes, direct compilation of files and 
many other features. Combined with A-Play’s proven teaching methods and huge numbers of ready-
to-use snippets and samples, JEdit and A-Play is a perfect match for note writing. 
 
It is simply a matter of taste. The piano is easy for the newcomer but much too slow for the trained 
user. If you are already a master in LilyPond, you might not need anything but a Microsoft Notepad. 
But as most of us certainly are not masters, we appreciate the automatic compilation and the other 
smart features in the LilyPondTool. 
 
The LilyPondTool is downloaded through the practical plug-in library in JEdit. The program is 
freeware like A-Play and the other programs mentioned in this manual. 
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NOTEWORTHY PLAYER 
 

 
 
The classic Noteworthy Player is still one of the favourite MIDI players and note viewers on the 
web. It is indispensable for all musicians working with scores or MIDI based music. You can drag 
files into the player or open them from within the player. We recommend that you buy the 
Noteworthy Composer, which is a fast and easy note-writing program (about 30$). The files can 
be exported to LilyPond format and edited in A-Play. 
 

http://www.noteworthysoftware.com/
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FILEANT 
 

 
 
The File manager FileAnt is a small, yet powerful file manager with the modern Tabs. We 
recommend FileAnt for Windows, because it means that A-Play is no more dependent on Windows 
explorer for basic LilyPond operations. 
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2. Lily Pond User Guide 
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The Lily Pond Music Language 
 

CRASH COURSE IN PROGRAMMING 
Inside Microsoft Word, Excel or a drawing program, there are a lot of codes. A code, also called a 
command, is a short text telling the program compiler (more on that later) to perform some 
predefined task when the user click on a button, for example change a word from normal to bold or 
change the colour from blue to red. All programs in the world are built that way. 
 
Like spoken languages, the program variants are called programming languages. The most famous 
example is C++, which was used for writing Microsoft Word and many other well-known 
applications. All these programming languages are generic, .i.e. they can be used for any kind of 
tasks from a text editor to the module of a Mars Lander. Programming languages written for one 
purpose only are rare, the archetypical example being AutoCAD, a technical drawing system. 
LilyPond is another prominent example. 
 

The History of LilyPond 
In 1999, two young musicians met in a youth symphony orchestra. Han-Wen and Jan were worried 
about the quality of the computer notes produced at the time, believing that the quality was 
downright unacceptable. Soon they became partners in an attempt to reproduce the “perfect” notes 
as the old engravers used to make them. It took a while, but eventually the program was ready and 
introduced as a GNU Open Source freeware. The music programming language was received with 
enthusiasm among professional musicians and composers, and soon became cult. 
 
If you compare the leading note writing software today, British Sibelius to LilyPond you will find 
that the freeware LilyPond almost matches Sibelius on all important features, if we remove exotic 
functions like scanning notes and automatic score production. Sibelius costs a fortune, and 
LilyPond is free, so what are you waiting for? Eh, a useful interface without having to program the 
music. That was a tough argument, and the LilyPond society has been waiting for years for a “real” 
note-writing application to appear. LilyPondTool is the closest attempt until now, but neither A-
Play nor LilyPondTool has solved the difficult problem of transferring the special LilyPond codes 
to a “box program” with the notes on the screen all the times. It is possible but tremendously 
expensive, especially as LilyPond is free with no income from sales. 
 
So until then, we are all going to become programmers. 
 

Math is Fun (No, it’s not) 
Many programmers are also musicians. Many musicians fail miserably in mathematics. How come 
that the two groups of musicians are so different? One obvious reason could be that theoretical math 
is invisible for a musician that needs to have the physical feeling of an instrument to understand 
musical math in the form of intervals, pitches and correlations between the notes. This is also math, 
but related to the physical body instead of abstract equations. Albert Einstein, who was one of the 
greatest mathematicians in the world, did very badly in school in math. So don’t worry, math is 
relative. 
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THE LILYPOND PROGRAMMING LANGUAGE 
Every programming language has a grammar – that’s why it is called a “language”. The grammar is 
a number of rules governing the behaviour of the program. Like in a spoken language, the 
programming language has spelling rules. But unlike the spoken language, you are going to be shot, 
if you break a spelling rule in a programming language. Let’s take a look at LilyPond and its rules, 
which were originally based on the C++ language. Codes are always written in a monotype font, 
normally courier (all the letters have the same width). 
 

1. The Backlash Character 
Here comes the first rule: All words beginning with a backslash \ is a command. Here are a few 
examples: 
 
\score 
\time 
\clef 
\relative 
 

2. Brackets Galore 
Here comes the second rule: All scores, systems and coherent elements must be embraced by 
brackets { }. Examples: 
 
{c e g e} 
c8 [f a bes] 
<c e g> 
^\markup { Am7 } 
 
Besides the \xxxcommand and the brackets, LilyPond uses common computer expressions with 
suffixes like \remove "Time_signature_engraver". 
 
Let us have a look at some basic codes: 
 
The Prologue Area In the prologue, the general paper format, the title of the music and other 
settings can be found. Here is an example from A-Play’s template collection: 
 
%%%%% Piano Solo %%%%% 
 
%%%%% PROLOGUE %%%%% 
\header { 
  title = "Piano Solo" 
  subtitle = "" 
  subsubtitle = "" 
  composer = "" 
  dedication = "" 
  opus = "" 
  piece = "" 
  arranger = "" 
  poet = "" 
  texttranslator = "" 
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  copyright = "" 
} 
#(set-default-paper-size "a4") 
\paper { 
  #(set-paper-size "a4") 
} 
\paper { 
   hsize          = 21\cm 
   vsize          = 28\cm 
   topmargin      =  1\cm 
   bottommargin = 0.5\cm 
   leftmargin     =  2\cm 
   rightmargin    =  2\cm 
   linewidth      = 17\cm 
} 

 
The paper definition works like the page settings of Word. The linewidth parameter is the max 
length of a system. 
 
The System A system is a voice/instrument. In LilyPond, a system is also called a line. There can 
be almost any number of systems, but if you want to produce a working MIDI file, you must restrict 
the number of systems to max 14 systems (for some reason, LilyPond doesn’t support the normal 16 
MIDI tracks (systems)). 
 
A system can be independently designed or ruled by global parameters set in the prologue. In A-
Play, we have placed the parameters in every system. The most important parameters are: 
 
%%%%% WRITE YOUR NOTES HERE - SKRIV NODERNE HER %%%%% 
 
 upper = \relative c'' { 

 

The recommended type of system is the relative system. A relative system contains notes 
without absolute pitches. You move up and down in the octaves by adding ‘ for up and , for 
down. The traditional conception of note pitches with marks 4-5 octaves marked with 
comma, an octave without a mark and 4-5 high octaves with ‘ signs is also supported. 
 
 \set Staff.instrument = "Piano" 

\set Staff.midiInstrument = "acoustic grand" 
 

The \set Staff.instrument code allows you to write the name of the instrument. The \set 
Staff.midiInstrument code attaches a MIDI instrument sound to the system. You can 
change the sound arbitrarily, for example changing from violin to pizzicato and back again. 
The MIDI instrument names can be found in the Score menu, Score Settings. If you 
introduces a spelling mistake in the MIDI instrument name, you will have a piano sound 
(default sound). So copy the instrument name, don’t “remember” it. 
 
 \clef treble 

\key c \major 
\time 4/4 
\tempo 4=100 
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Here are the indicator definitions: The clef (in this example treble G), the key is c with the 
\major command – LilyPond supports modal scales, so the “c” scale could be many 
different scales. Finally, we have the time signature and the tempo. 
 
 a4 b4 c4 d4 

 

The notes will be explained soon!  
 
The Score Area The \score area is a set of commands for PDF and MIDI layout. The main 
structure is: 
 
\score { 
  \new StaffGroup << 
    \new Staff    << \upper >> 

    \new Staff    << \lower >> 
>> 
 
 \layout { 

  \context{ 
  \Voice 
  \remove "Note_heads_engraver" 
  \consists "Completion_heads_engraver" 
  } 
} 
 \midi { } 

} 
 
\version "2.6.5" 

 
Standard Staff In A-Play, we have decided to use a simple, uniform score syntax. In LilyPond, 
you can make a lot of specialized score settings, but we believe that simple is beautiful. When you 
have learned the whereabouts of LilyPond, you can expand and improve the score any way you like. 
 

 is the main staff, the StaffGroup. There are other staffs, see the Score menu, Settings. 
 

 is the system, in this case the upper part of a piano staff. The systems are printed in the same 
order as in the \score setup. 
 

 is the \layout, which if often empty or with a number of general layout commands. The 
mystical code in the A-play templates is a special command that forces LilyPond to allow notes to 
“pass over” from one bar to another with a tie in between. This is not standard LilyPond, but 
necessary to avoid errors in complex scores or when working with manually recorded MIDI files. 
 

 is the MIDI area. In standard LilyPond, you have the tempo, but in A-Play, we prefer to have the 
tempo statements locally in the systems. 
 
Remember to end each file with the version number, which is used when updating to the score to a 
new LilyPond version. 
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Caution The prologue and score areas are normally not touched except for changing titles, whereas 
the systems are the creative area. 
 

NOTES 
The notes of LilyPond are peculiar compared to traditional notes, as they have absolute note names 
and don’t use # and b. For example C# D# E are written cis dis e and Ab Gb F are written as 
ges f. 
 
Here is the full spectrum of notes: 
 

Sharp 
c cis d dis e f fis g gis a ais b 
(enharmonic: eisis bisis) 
 

Flat 
c des d es e f ges g as a bes b 
(enharmonic: ceses feses) 
 

Rests 
r 
 
Please note that all note names and the other LilyPond codes are case sensitive. If you write in 
capital letters, when not appropriate, the code simply doesn’t work and you will get an error 
message when trying to compile the score. 
 
 
Duration is stated with a number after the note name, e.g. gis8 or a16. The following duration 
values are valid: 
1 (1/1)  2 (1/2)  4 (1/4)  8 (1/8)  16 (1/16)  32 (1/32)  64 (1/64)  
 
Beams are written by adding [] around the beamed notes: Examples  d [e fis g]  b [cis 
dis fis] 
 
Don’t place a beam over a rest (bad) example: c [e f r] 
 
The first note in a group, e.g. a beamed group is placed before the bracket. 
 
Chords are written within sharp brackets <c e g>4. The duration is placed after the bracket. 
 
Ties are written with a tilde ~, for example c2 ~ c4. 
 
 
Besides the notes mentioned in this section, there are several effect signs, text, dynamic signs etc. 
See the reference section or in the menu pallets. 
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Fundamentals 
 
Double-click on the A-play.htm file or on a shortcut to the program. The start up 
screen with the blue musicians appears. This is the Instruction Manual, you are 
reading right now. 
 

CREATE A NEW FILE 
 Open the text editor and click on New. 

 Open the Score menu and click on Templates. Choose a template and click three times in the 
yellow copy pad to mark all the codes. Use ctrl + c or right-click and select copy. 

 Copy the template into the new text file and save it with a name. 

 Very important The file extension (the last part of the file name) must be .ly, for example 
myfirstfile.ly. 

 The template contains one or more predefined systems. You can now change the system(s) 
according to your needs. 

 

CREATE SYSTEM (INSTRUMENTS) 
You may proceed with the single system to produce a vocal score with chord boxes, as rock and 
jazz musicians often do. Or you may create a number of extra systems, if you are writing an 
orchestra score. See the Format menu, MIDI to select a MIDI instrument for the system. 
 

 Click Save to save the changes in the Score. 
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WRITING THE NOTES 
Simple is beautiful, an old saying goes. This goes for A-Play 3.0 as well. In 
NORDISC, we (sometimes) like simple designs, so let’s start with an empty system 
in the text editor. Add A-Play and a few menu pallets, and we have the working area 
of A-Play. 
 

 
 

FAST NOTE TYPING 
The basic principle of A-Play is speed. The number of notes in a score can be overwhelming. A 
typical symphony score consists of about 1200 bars. Each bar has an average of two notes. With 16 
systems (many real-life scores have 24 systems!) the total adds up to an astonishing 38400 notes. 
Consider the difference between using the mouse to insert the note – which is also possible in A-
Play of course – and keyboard based note typing. Here is an example: 
 
Keyboard 1. Type c4 for example. Copy the note, including a space after the duration and copy 

the necessary number of notes. Edit the duration and pitch afterwards. 
 
Mouse 1. If the Notes menu is open, copy the desired notes, one by one. For faster action, 

we have added durations to the notes. 
 2. Copy the note in the copy pad of the notes menu or directly in the score (within the 

system brackets {}). 
 
Both processes are simple and relatively fast. But the keyboard method is about double as fast as the 
mouse method. Don’t think twice! 
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For mouse enthusiasts, the notes menu will be home most of the time when using A-Play. From 
here, you can create notes and rest, controlling beams and dots. 
 

Pitch 
 If you use the JEdit editor with the free LilyPondTool, you can play the virtual piano to select 

pitch. 

 If you cannot play the piano yet, learn it the easy way! A-Play includes Basic Piano, where you 
can learn to play simple piano pieces. 

 

Duration 
 Insert 1, 2, 4, 8, 16, 32 or 64 after the note (no spaces!). 

 

Flag / Rest 
 Use c [d e g] (example) to force beams. If you don’t force the beams, LilyPond will insert 

beams automatically, but not always the way you want it. 

 Insert a rest: r4 (example. 

 

Dots 
 Select 1 or 2 dots or remove the dot(s) c. e.. (example). 

 

Chords 
 To create a chord, place the notes inside sharp brackets. Place the duration after the brackets. 

Example <c e g b>2. 

 

Bar Line 
 Insert a bar line | after each bar. LilyPond automatically inserts bar lines, but by forcing a bar line 

it is easier to read the score and a wrong number of durations (5 x 1/4 for example) will cause an 
error message. 

 

Create and Proceed 
 Create the notes. Click Save every five minutes to make sure that you don’t waste 1 hours of 

work by mistake. 
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Control the Score by Playback of the Music 
 When you have compiled the score, open the Noteworthy Player (windows) or a MIDI Player 

and play the music. Check the notes for errors. Correct the errors and re-compile the score. 
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Beginnings 
 
This is an instruction manual for a professional note-writing program. But is it 
possible to use a computer aided note-writing program without a relatively high level 
of knowledge in music theory and orchestra arrangement? The answer is both yes and 
no. An experienced musician who has never learned to read notes could still be a 
“yes”, although he/she would have to learn the notes the hard way. The background 
of modern musicians varies from the rock guitarists who have played for 30 years and 
the amateur composer with her upright piano and her blank note sheets. We know 
that many of the LilyPond users are professional classical teachers and musicians, 
and they have raised the quality demands sky-high. But we still need to catch the 
imagination of the multitalented youngsters of today. They do read books and study 
scores, but they play rock, funk and jazz. We want to include the modern music in the 
exciting world of the LilyPond musical language. 
 
 

HANDWRITTEN NOTES 
 

Learning the Basic Notation Skills 
Today we have music everywhere from the IPods and the laptops. The world seems far away from 
the meagre times of the 19th century, where music meant live music and only that. If you wanted 
music, you had to play it yourself, and to play the music you needed to learn to read the notes. 
Generations of women grew up playing the piano and gave the love of music to their kids, who 
learned to play themselves. But in the 1930-ies, the record industries had taken over the music in 
the homes and replaced it with radios and gramophones. It took 30 years, two generations, and the 
ability to play notes had almost disappeared. 
   This is the musical year zero, we start from scratch: Notation is difficult, full of conservative 
opinions of what is allowed and what is not – and worst of all – it is  b o r i n g. In A-Play we have 
included basic music primers for music theory and piano. They are small but they cover the basic 
elements of note writing and piano playing. That’s at least a beginning. 
 
And the kids need teachers, too. Who volunteers???? 
 

Writing Tunes 
If a modern rock musician has attended a serious musical school, he/she is probably able to write 
down notes. He or she will no doubt be writing songs searching for the first questions in a 
songwriters mind: Who am I? Why do I sit here? Where does this guitar come from? And: “I wish I 
could remember that incredible song, I made last night”. With LilyPond, the rock musician – and 
the jazz musician too – can fulfil a dream of note writing and sight-reading. But it is a demanding 
task. You have to do it alone behind the piano writing down notes in hand and entering the music in 
a LilyPond score. That’s the magic of music – so simple and so complicated. 
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Arrangements 
After 3-4 years, the talented young rock musician has learned how to write songs, and it is time to 
record the first album. The producer wants a great horn section, a string quartet and two opera 
singers. “Right, you need what? A score with the voices? Eh, just wait a minute!” Two hours and 
150€ in studio time later – “here you are.” The opera singers: “We want them in A minor, not in D 
Minor.” The songwriter returns to LilyPond and places the \transpose command. He/she waits for 5 
minutes, prints the scores and returns with the final sheets. Long live the note-writing programs. 
   A fictive story but close to the real world. Not to mention the guitar tablature voice we had 
promised the guitarist. Just forgot to write it down yesterday, but we have the laptop here. 15 
minutes later, the guitar player has emptied his coffee latte and begins rehearsing the guitar part. 
 
Modern life with modern tools. 
 
 

WORKFLOW 
A young musical composer has received his first assignment from the local music centre. He has 
been asked for a 45 minutes work for full symphony orchestra. He has 6 months to finish the work 
and only 2 weeks to rehearse it with the singers and the orchestra. He is paid less than the girls who 
sell tickets behind the counter earn in a month, but he is the happiest composer this side of 
Antarctica. 
 

What Do You Want to Express? 
First problem: The story is a classical plot taking place during the Balkan wars. It’s a very political 
libretto with a breathtaking female character who wants to make peace in the world and stop the 
plundering of the Indians, but cannot take care of her own child. A modern, believable story. 
   But is the story relevant to the audience? Should they cry? Should they volunteer for Green 
Peace? Or should they regard the whole thing as a cabaret with ambitions? 
 
Our young composer decides that they should cry. If he is going to cry over the reviews so should 
the audience. 
 

What Style? 
The songs are already written, but they are hard to place stylistically, so the producer demands that 
they should be in Balkan style. The composer is not very happy, but he finds some examples on the 
web and locks himself into a rehearsal studio. 
 
When he comes back three days later, the score is in John Williams style, and the producer, who has 
forgotten all about the Balkan stuff, thanks the composer for listening to his advice. “I knew that 
John Williams style was the right thing for your musical”.  
 

What Kind of Orchestra 
John Williams is a fantastic arranger with a tremendous orchestra sound. Our composer, sad to say, 
lacks 20 strings, all the percussion instruments and most of the brass players, so he will have to 
remake his original score into a glorified string quartet with choir – interesting. 
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PREPARING A SCORE 
The orchestra is not very big, but it also has a lot of interesting possibilities. The woodwinds are 
good, and the cellos and basses are tight and never out of tune. So let’s base our orchestra on 
woodwinds and deep strings. Terrific. Oh, and the choir, too. They will kill me, if I forget them. 
 

Sound and Texture 
A quick look at the instrumental voices: Woodwinds are good at moving fast, playing in harmonies, 
and long gliding tones over the rest of the orchestra. The sound of clarinet, oboe and English horn? 
Very renaissance-like including the cellos. This kind of texture is like the holes in the Swiss cheese. 
The pauses are equally important as the fat sound of the brass. A nice carpet of holes and vibrant, 
light woodwinds. And below the birdies, we have the brutal force of the Balkan music, the 
stampeding cellos and basses, the fiery violins and the muffled trumpets. Hey, where is my pen and 
paper! 
 

Choice of Instrument 
The orchestra now consists of strings: 8 violins, 4 violas, 4 cellos and 2 basses, woodwind: 2 
clarinets, 1 oboe, 2 English horns and 1 French horn. The brass group has 1 trombone, 2 tubas 
(great, more bass) and 1 bass saxophone (not so great, he’s always out of tune). The choir consists 
of 6 sopranos, 5 altos and 4 basses – no tenors for our Beethoven. Great – let’s weld this lot together 
with dynamics, movements and surprises. Never forget the surprises; would be like a superb diner 
without a dessert. A complete dinner for 43 musicians and a composer. 
 

How Many Bars? 
Back at the piano, the composer starts working out the music from hundreds of sketches from the 
last 5 months. He knows it should last about 45 minutes and be a funny and romantic musical over a 
dark background of war and war crimes. But how long does 1 minute actually take in bars in, say, 
3/4? Counting, guessing. Then calculating the total number of bars. 
   Let’s give it a try: Tempo = 110, meter 4/4, around 1,000 bars. Just copy and paste 1,000 times 4 
1/4 notes per bar – a huge file. Compile the giant thing, open the MIDI file in the media player. 
Great! This was almost 45 minutes. 
 
Contrast 
 Halfway through the arrangement, Beethoven junior has learned how to contrast the various 

instrumental groups, one sort against another sort, or mixed groups in many coloured attacks, 
hide and seek between the high, thin woodwinds and the thick, monstrous cellos and basses. 
Contrast – life. 

 
Overlapping Voices 
 The strings are not static anymore. They soar high above the common instruments, but never 

follow the basic rhythms of the ordinary voices. Freedom – like mysterious clouds and soft 
shades of light. Then following the rhythm of the full orchestra, triumphant, ecstatic. 

 



A-Play Instruction Manual 
 

32 

Level of Polyphony 
And the best thing, when you learn the trade: Polyphonic movements across the fast clusters of the 
strings. The trombone and the French horn stand out with their own melodies, complex triplet 
figures in 5 to 4, sounds natural to the audience and costs the composer a round in the pub after the 
first night. It just feels right, it moves. The orchestra is ready, the time has come. The curtain 
rises… 
 

INSTRUMENTATION 
We will leave young Beethoven to his great night and get down to the instrumentation of various 
other orchestra formats. 
 

Rock Band 
A rock band will need 1 or 2 guitars, a bass, a drummer and maybe a piano. This makes 2 x 
5 systems per page. You write the arrangement down together with the band and later you write the 
notes down in LilyPond. You don’t have to be very precise – the band is not going to play your 
notes anyway, but something vaguely reminding of the original score. 
 

Jazz Band 
A jazz band needs piano, bass, drums and 3-4 horns. This makes 2 x 6 systems per page. A little 
pressed, but possible. Just write a skeleton arrangement, unless you are writing for a big band, 
which over the time has developed into a sort of symphony orchestra. If you play old jazz, you 
should only make some sketches of the intro, the interlude and the end. The rest is out of your 
control. 
 

Classical 
A classical orchestra depends on the number of actual players. If you arrange for a symphony 
orchestra, you will need an A3 printer for the BIG score. Later you will transpose and print out the 
necessary voices to the musicians and singers. 
 
 

LAYOUT TIPS 
Customizing the Score 
You can use the A-Play templates as they are, or you can add your own layout. This takes time to 
learn, and you will need the LilyPond forum and other notation expert groups to guide you into the 
best practice of score layout. 
 

Paper Format 
The paper size depends on your local paper types, US letter or International A4. You also need 
margins and titles. Look at old scores and get inspired. 
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Placement of Small Elements 
Change the format, size and position of the elements, preferably the small ones. This can be very 
useful when it comes to high notes towering over the system or texts being hidden by 1/16 notes. 
 

Copy Existing Music 
 
Counting bars 
 If you are transferring old music to LilyPond format, there are some basic tricks to learn. To 

make sure, you don’t miss a bar you will have to count all bars in the original score. Use a 
spreadsheet, if you need to recalculate the bars at some point. 

 
Insert Empty Bars 
 When you have counted the bars, you should make a mock-up similar to young Beethoven’s test 

file. Make only one system – you will copy the other systems later. Copy and paste the desired 
number of bars.  

 
Double check the Number of Bars 
 Compile and print the PDF file. The bars are numbered in the score, so you can use the print to 

check the number of bars with the original score. 

 
Copy Contents to All Systems 
 When you have checked the number of bars, you must check for new time signatures in the 

score, new keys and other common bar indicators. 

 Last step: Copy the necessary number of systems, and add the correct clefs. Now you are ready 
to type in the notes. 
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OPTIMISING YOUR INSTRUMENT NOTATION 
 

Piano 
 Always place correct pedal marks and phrase slurs to ease the life of the piano player. Make the 
layout as simple as possible and try to avoid too many rests. 

 Use octave signs when necessary, but consider a clef change, if the treble notes dive too deep 
into the bass area, in order not to confuse the bass and the treble notes – a system with two bass 
clefs are acceptable for a while. 

 If you are writing simple piano arrangements, remember to add chord symbols or even guitar 
boxes to enable other musicians to join you or to the play the piece on their own. If you are 
writing music for children or difficult runs, please consider adding fingering numbers over the 
notes. Please see the Notes menu, Effect Signs. 

 

Guitar 
 Remember to use the treble clef with a deep 8va to allow for correct MIDI pitch. See the Format 
menu, Clefs. 

 If possible, use both traditional notes and tablature, as the guitar cannot be rendered faithfully in 
traditional notes (the “B string pos. 5 = open E string” problem). It also makes life easier for the 
many guitar players who only use tablature. 

 Always add the new guitar effect signs, hammer on, bend etc. Please see the Notes menu, Effect 
Signs.  

 

Bass 
 Remember to use the bass clef with a deep 8va to allow for correct MIDI pitch. See the Format 
menu, Clefs. The acoustic bass is an exception, as it sounds right in MIDI when written in 
standard bass clef. 

 Some bass players (in the US mostly) use bass tablature. LilyPond supports bass tablature, see 
the Score Settings menu, Tablature. 

 Modern bass players often use overtones, harmonics. Remember to use the harmonics symbols 
although the notes do no sound in MIDI. See the Notes menu, Effect signs. 

 

Drums and Percussion 
 Most drummers today, prefer the percussion clef notation, but there are still some arrangers, that 
use the bass clef (bass drum deep c, hi-hat f# and snare drum d or e). LilyPond does not support 
the popular alternative drum tablature at the moment (see how to use it in All Aspects of ROCK 
& Jazz/volume 4 Drums). 
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 In A-Play, we use chord-like drum notation, as it is easier to read than polyphonic lines. 
Remember to have a minimum duration running all the time, typically in 1/16 beats. See the 
drum examples in the templates in the Score menu. 

 Use the correct boogie notation – see the Drum patterns in the Tools menu, Phrases. Do read the 
polyrhythm section in the same menu for inspiration to work with advanced triplets. 

 

Strings 
 Use the effect signs, e.g. harmonics and tremolo; see the Notes menu, Effect signs. 

 When necessary, collect some or all the violins in one system. Not always acceptable, but it 
saves 1 to 2 “expensive” systems, that will come in handy for a bassoon or a French horn. 

 

Organ 
 Base the organ layout on the piano examples in the piano templates (e.g. no. 2). Add an extra 
bass system for example called organPedals for the pedals. 

 Use the extremely flexible sounds in LilyPond to manipulate the sound of the organ. For 
example: Give the pedals a powerful organ sound (in the MIDI settings string) and a “normal” 
organ sound for the two manuals (keyboards). 

 To use the MIDI sound possibilities in LilyPond to its full potential, change organ sound every 
time, the original score asks for a new setting. You don’t have all the many colours of a real 
organ, but it sounds much more like a genuine organ with all its wonderful details. 

 

Vocal 
 When writing vocal lines for many verses, please keep in mind to insert two notes with a tie in 
places where the verses sometimes use one, sometime two syllables. Always mark a melisma (a 
syllable sung over more than one note) with a phrase slur. See the Notes menu, Ties. 

 Do not use the dated tradition of writing vocal notes without beams. We do not use wigs 
anymore, for that matter. 

 Lyrics should be legible. If needed, insert a \break before the automatic line break to make more 
space in the bars. If there are many notes, use a smaller font. See the Notes menu, Text. If you 
want the text to follow a specific note, use \markup text. See the Text menu. 

 For vocal SATB arrangements – see the LilyPond templates on http://.lilypond.org. 

 

http://.lilypond.org/
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Standard Templates 
 

NEUTRAL 
 See the Score menu, Templates. 

 - 01 Simple (One System) 

 - 02 Piano Solo 

 - 03 Piano and Vocal 

 - 11 Blank Simple (One System) 

 - 12 Blank Piano and Vocal (Piano and Vocal) 

 

ROCK 
 See the Score menu, Templates. 

 - 06 Rock Trio (Vocal, Guitar, Bass and Drums) 

 - 07 Rock Tablature (Voc, Piano, Guitar, Bass and Drums) 

 - 08 Rock String (Band and Strings) 

 

JAZZ 
 See the Score menu, Templates. 

 - 04 Jazz Trio (Piano, Vocal, Bass, Drums) 

 - 05 Jazz Quartet (Piano, Vocal, Bass, Drums and Sax) 

 

CLASSICAL 
 See the Score menu, Templates. 

 - 09 Symphony Orchestra (Basic) 

 - 14 Blank Symphony (Basic Symphony Orchestra) 
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Formatting Tips 
 

NOTES 
 See the Notes menu, Notes. 

 

BAR 
 See the Notes menu, Bar lines. 

 

TEXT 
 See the Notes menu, Text. 

 

EDUCATION 
 See the Tools menu, Teachers. 

 

SCORE LAYOUT 
 See the Score menu, Settings. 

 

TROUBLE SHOOTING 
 When you compile the score, there will according to Murphy’s law always be errors half of the 
times. A LilyPond warning appears pointing to the error(s) found in the score. Correct the 
error(s) and compile again. You cannot compile a score with errors. 

 Here are some typical sources of errors: 

 A bracket is missing. All brackets are pairs and without the end (or begin) bracket, LilyPond 
won’t compile your master piece. Missing brackets also happens with chords, markup text and in 
other “mini” bracket situations. 

 A missing \ or no space between two notes are common error causes. Remember that LilyPond is 
case sensitive; you cannot write the notes with capital letters for example. But when using 
LilyPond special codes, you must use capital first letters as indicated in the menu pallets. 

 A more tricky error could be using a wrong version of LilyPond. And of course there are 
sometimes bugs in the program. 

 If you find a bug, please write to LilyPond on http://lilypond.org.  

http://lilypond.org/
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Advanced Tips 
 

ADVANCED METERS 
 See the Score menu, Settings and the Tools menu, Rhythm. 

 

ADVANCED SCALES 
 See the Score menu, Settings and the Format menu, Scales. 

 

ADVANCED CHORDS 
 See the Score menu, Settings and the Tools menu, Chords. 

 

ANCIENT MUSIC 
 See the Tools menu, Ancient and the LilyPond manual on http://lilypond.org. 

 

MOVE ELEMENTS 
 See the Format menu, Layout. 

 

PROGRAMMING THE SCORE 
 See the LilyPond manual on http://lilypond.org. 

 

IMPORT / EXPORT FILES 
 See the Score menu, Import/Export. 

 

http://lilypond.org/
http://lilypond.org/
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Reference 
 

SCORE 
The Score Menus contain the basic settings of a score file. 
 

 There are readymade templates for rock, jazz and classical music and the templates make it easy 
to change paper size from International A4 to US letter format. 

 The Settings menu contains all necessary formatting tools for a score: Page settings, Brackets 
and staves, Titles, MIDI instrument assignment, Meters, Keys (including modal scales), clefs, 
drum notation, tablature and tempo. 

 The advanced section covers polyphonic voices, tablature and drum notes, reorganizing the 
system layout of the instruments and transposing. 

 The Import/Export menu offers conversion from MIDI to LilyPond format (sometime works) 
and conversion from Finale (works fine) and the NoteWorthy Composer (very experimental). 
You can also export scores to PNG pictures (works fine), and you are taught how to copy and 
paste from PDF scores (always works). 

 

Templates 
01 Simple (One System) 
02 Piano Solo 
03 Piano and Vocal 
04 Jazz Trio (Piano, Vocal, Bass, Drums) 
05 Jazz Quartet (Piano, Vocal, Bass, Drums and Sax) 
06 Rock Trio (Vocal, Guitar, Bass and Drums) 
07 Rock Tablature (Voc, Piano, Guitar, Bass and Drums) 
08 Rock String (Band and Strings) 
09 Symphony Orchestra (Basic) 
10 Absolute Pitch (Vocal) 
11 Blank Simple (One System) 
12 Blank Piano and Vocal (Piano and Vocal) 
13 Blank Rock Quartet 
14 Blank Symphony (Basic Symphony Orchestra) 
 

Score Settings 
Paper Format 
Page Format 
Brackets / Staves 
Heading 
Instrument Names 
MIDI Instruments 
MIDI Volume 
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Meter 
Clefs 
Drum Notation 
Tablature 
Key 
Tempo 
 

Advanced 
Polyphonic Music 
Tablature 
Guitar Tabs 
Bass Tabs 
Drums 
Drum Names 
Groups 
Transpose 
 

Import/Export 
Import 
 Import MIDI to LilyPond 
 Import Finale to LilyPond 
 Import NoteWorthy to LilyPond 
Export 
 Primitive Export to Word 
 Export LilyPond to PNG 
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NOTES 
The Notes Menus are the heart of A-Play. You will probably be working in the Notes menu most of 
the time, as you have all the necessary tools at hand all the time. A good workflow would be 
creating the systems, one at a time, and copying them from the working area of Notes to the text 
editor. Don’t wait hours for copying the system, as you cannot save the text from the text area. 
 

 
 

 The notes can be copied and pasted including duration. It is easy to copy, but it’s much faster if 
you learn the note names by heart and type them instead of using the mouse. The Notes Menu 
also contains duration, octaves, beams, ties, triplets, tablature and percussion notes, manual 
chords in all keys and automatic chords. 

 The Bar Lines Menu contains all available bar line types, including the special Fine and Fade 
endings. 

 The important Text Menu contains a lot of tricks on how to optimise the use of text and lyrics in 
the score. You are also taught how to change fonts and write intelligent lyrics for opera and 
musicals. A small musical expressions dictionary is included in the menu, and text spanners, i.e. 
how to mark a number of bars for example when using the crescendo sign. 

 The Ties menu shows how to use ties and slurs. 

 The Effects Menu is a catalogue of effects for various instruments. It also covers trills and 
harmonics, both natural and artificial. Finger settings for piano are also covered. 

 The Octaves Menu explains how to use the traditional octave signs and the new octave clefs.. 
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 The Repeat Sign Menu covers the classical repeat signs and the rock/jazz system of / repeat 
signs. A programming example on how to “unfold” repeats is quoted. This is not for beginners. 

 

Bar Lines 
 

Text 
Markup Text 
\addlyrics 
\lyricmode and \lyricsto 
Available Fonts 
Musical and Opera 
Text Spanners 
Language Support 
Music Expressions 
Metronome 
Tempi 
Changes 
Character 
Dynamics 
 

Ties 
Standard Ties 
Legato Slurs 
Phrase and Legato Slurs 
Vocal Slurs 
 

Effects 
Trills 
Signs 
Guitar and Bass Effects 
String Effects 
Piano Effects 
Vocal Effects 
Harmonics 
Fingering 
 

Octave Signs 
 

Repeats 
Traditional Repeat Signs 
Guitar Repeat Signs (Percent Style) 
The MIDI Unfold Repeats Trick 
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FORMAT 
The format menus are simply excerpts from the Score Settings menu plus a menu for advanced 
score layout. The small Format menus are meant for changing time signature, key and other 
changes in an existing system/voice. 
 

 The Tempo menu is a piece of minimalist art with only one subject, tempo. 

 The Meter Menu covers the whole range of meters, including the compound/odd meters. 

 The Key Menu contains a complete list of keys, including major, minor, modal scales, blues, 
whole tone scales, chromatic and diminished jazz scales. The Key Menu also explains about the 
fantastic micro tone feature of LilyPond and introduces the use of absolute pitch, i.e. the 
traditional octave system. The last point in the menu is transposing examples. 

 The Clef Menu shows the whole spectrum of clefs including percussion and tablature. The 
tablature explanation is a must for users of guitar tablature. 

 The MIDI Menu contains volume control through Dynamic signs (strange idea, but it works). 
The menu also explains about instrument names and MIDI sounds, including the complete list of 
LilyPond MIDI sounds. And remember: Copy, don’t guess the MIDI sound name or your score 
will be piano only. 

 The Layout Menu teaches you how to created forced beams, early (partial) bars, rest for 
symphony orchestra scores, changing width and space between systems and the whole range of 
staff possibilities in LilyPond. The Layout Menu also shows you how to move elements and to 
remove notes/rest from a bar. 

 

Tempo 
 

Meter 
Straight Meters 
5- and 7-part Meters 
9-Part Meters 
10-Part Meters 
1-Part Meters 
13-Part Meters 
 

Key 
Keys 
Microtones 
Absolute Pitch 
Transpose 
 

Clef 
Treble Clefs 
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Bass Clefs 
C Clefs 
Drum Notation 
Tablature 
 

MIDI 
MIDI Volume 
Instrument Names 
MIDI Instruments 
 

Layout 
Bar 
System 
Score 
Moving Elements 
 
 

TOOLS 
The Tools menus cover some of the advanced parts of the LilyPond language. Especially the 
Special Chords menu has a wealth of chord techniques and ready made chord boxes for guitar. 
 

 The Special Chords menu contains a valuable list of guitar chord boxes ready to use in your 
score. The boxes are carefully designed for easy fingering on the guitar. There is a section on 
how to create chord boxes (fret diagrams) yourself in three different ways. The advanced 
sections cover stack and cluster chords and a mini course in harmonizing voices, inversion of 
chords and parallelism, loved by metal rockers and hated by the conservatories. 

 The Triplet (Polyrhythm) menu shows some very advanced triplet forms in straight and odd 
meters. Nested triplets are some of the most difficult rhythms to play. Read the Music Theory 
book for more on triplets and polyrhythms. 

 The Phrases Menu contains a number of useful guitar, bass and drum phrases/patterns. You can 
copy the boogie rhythms and other drum patterns to your own scores to create effective modern 
drumming, jazz or bass styles. 

 The Advanced Rhythm Menu is small but really advanced. Lear how to compose without firm 
meters or checkout the French composer Messian’s rhythm transposition techniques. 

 The Dynamic Signs Menu is a complete list of dynamic signs. 

 The Teachers Menu is dedicated to music teachers who work with very young students. It is 
basically a tutor on how to remove elements like note lines, clefs, time signature etc. This is very 
important when teaching rhythm values. The example in the menu is also a project for the kid to 
learn the names of the elements that are removed from the score. You will also learn to make a 
rhythm bar and note heads with the letter of the pitch. 



  A-Play Instruction Manual 
 

  45 

 The Ancient Menu is only a fragment with an example of a Gregorian chant and a mensural 
example. Use the LilyPond manual to discover the world of the medieval music. 

 

Special Chords 
Major and Minor Chord Boxes 
Movable Chord Boxes, Advanced Jazz 
Creating a Chord Box 
Combining Chord Boxes and Chord Symbols 
Chord Symbols Only 
Stacks of Quarters and Fifths 
Clusters 
Harmonize 
Parallelism 
Inversions 
 

Polyrhythms 
Polyrhythms in One Meter (Triplets) 
Advanced Polyrhythmic Groups 
Nested Triplets 
True Polyrhythms 
 

Phrases 
Guitar Phrases 
Bass Phrases 
Drum Patterns 
 

Advanced Rhythm 
Floating Rhythm 
Transpose Rhythms 
 

Dynamics 
 

Teachers 
 

Ancient 
 
 

http://lilypond.org/
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HELP 
Help 
All menu pallets are equipped with Help. Learn about the properties and functions of A-Play and 
LilyPond. 
 

Music Theory 
An excerpt from the All Aspects of ROCK & JAZZ series, volume 1, Music Theory. 
 

Basic Piano 
An excerpt from the All Aspects of ROCK & JAZZ series, volume 5, Basic Piano. 
 

About A-Play 
Version number and copyrights. 
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3. Appendix 
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Copyright Disclaimers and 
Licenses 
 

GNU GENERAL PUBLIC LICENSE 
Version 2, June 1991 
 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 
59 Temple Place, Suite 330, Boston, MA  02111-1307  USA 
Everyone is permitted to copy and distribute verbatim copies 
of this license document, but changing it is not allowed. 
 
Preamble 
 
The licenses for most software are designed to take away your freedom to share and change it.  By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and 
change free software--to make sure the software is free for all its users.  This General Public 
License applies to most of the Free Software Foundation's software and to any other program whose 
authors commit to using it.  (Some other Free Software Foundation software is covered by the GNU 
Library General Public License instead.)  You can apply it to your programs, too. 
 
  When we speak of free software, we are referring to freedom, not price.  Our General Public 
Licenses are designed to make sure that you have the freedom to distribute copies of free software 
(and charge for this service if you wish), that you receive source code or can get it if you want it, 
that you can change the software or use pieces of it in new free programs; and that you know you 
can do these things. 
 
  To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or 
to ask you to surrender the rights.  These restrictions translate to certain responsibilities for you if 
you distribute copies of the software, or if you modify it. 
 
  For example, if you distribute copies of such a program, whether gratis or for a fee, you must give 
the recipients all the rights that you have.  You must make sure that they, too, receive or can get the 
source code.  And you must show them these terms so they know their rights. 
 
  We protect your rights with two steps: (1) copyright the software, and (2) offer you this license 
which gives you legal permission to copy, distribute and/or modify the software. 
 
  Also, for each author's protection and ours, we want to make certain that everyone understands 
that there is no warranty for this free software.  If the software is modified by someone else and 
passed on, we want its recipients to know that what they have is not the original, so that any 
problems introduced by others will not reflect on the original authors' reputations. 
 
  Finally, any free program is threatened constantly by software patents.  We wish to avoid the 
danger that redistributors of a free program will individually obtain patent licenses, in effect making 
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the program proprietary.  To prevent this, we have made it clear that any patent must be licensed for 
everyone's free use or not licensed at all. 
 
  The precise terms and conditions for copying, distribution and modification follow. 
 
GNU GENERAL PUBLIC LICENSE 
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 
 
  0. This License applies to any program or other work which contains a notice placed by the 
copyright holder saying it may be distributed under the terms of this General Public License.  The 
"Program", below, refers to any such program or work, and a "work based on the Program" means 
either the Program or any derivative work under copyright law: that is to say, a work containing the 
Program or a portion of it, either verbatim or with modifications and/or translated into another 
language.  (Hereinafter, translation is included without limitation in the term "modification".)  Each 
licensee is addressed as "you". 
 
Activities other than copying, distribution and modification are not covered by this License; they 
are outside its scope.  The act of running the Program is not restricted, and the output from the 
Program is covered only if its contents constitute a work based on the Program (independent of 
having been made by running the Program).  Whether that is true depends on what the Program 
does. 
 
  1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in 
any medium, provided that you conspicuously and appropriately publish on each copy an 
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this 
License and to the absence of any warranty; and give any other recipients of the Program a copy of 
this License along with the Program. 
 
You may charge a fee for the physical act of transferring a copy, and you may at your option offer 
warranty protection in exchange for a fee. 
 
  2. You may modify your copy or copies of the Program or any portion of it, thus forming a work 
based on the Program, and copy and distribute such modifications or work under the terms of 
Section 1 above, provided that you also meet all of these conditions: 
 
a) You must cause the modified files to carry prominent notices stating that you changed the files 

and the date of any change.  
b) You must cause any work that you distribute or publish, that in whole or in part contains or is 

derived from the Program or any part thereof, to be licensed as a whole at no charge to all third 
parties under the terms of this License. 

c) If the modified program normally reads commands interactively when run, you must cause it, 
when started running for such interactive use in the most ordinary way, to print or display an 
announcement including an appropriate copyright notice and a notice that there is no warranty 
(or else, saying that you provide a warranty) and that users may redistribute the program under 
these conditions, and telling the user how to view a copy of this License.  (Exception: if the 
Program itself is interactive but does not normally print such an announcement, your work 
based on the Program is not required to print an announcement.) 
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These requirements apply to the modified work as a whole.  If identifiable sections of that work are 
not derived from the Program, and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those sections when you distribute them 
as separate works.  But when you distribute the same sections as part of a whole which is a work 
based on the Program, the distribution of the whole must be on the terms of this License, whose 
permissions for other licensees extend to the entire whole, and thus to each and every part 
regardless of who wrote it. Thus, it is not the intent of this section to claim rights or contest your 
rights to work written entirely by you; rather, the intent is to exercise the right to control the 
distribution of derivative or collective works based on the Program. 
 
In addition, mere aggregation of another work not based on the Program with the Program (or with 
a work based on the Program) on a volume of a storage or distribution medium does not bring the 
other work under the scope of this License. 
 
  3. You may copy and distribute the Program (or a work based on it, under Section 2) in object 
code or executable form under the terms of Sections 1 and 2 above provided that you also do one of 
the following: 
 
a) Accompany it with the complete corresponding machine-readable source code, which must be 

distributed under the terms of Sections 1 and 2 above on a medium customarily used for 
software interchange; or, 

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a 
charge no more than your cost of physically performing source distribution, a complete 
machine-readable copy of the corresponding source code, to be distributed under the terms of 
Sections 1 and 2 above on a medium customarily used for software interchange; or, 

 
c) Accompany it with the information you received as to the offer to distribute corresponding 

source code.  (This alternative is allowed only for noncommercial distribution and only if you 
received the program in object code or executable form with such an offer, in accord with 
Subsection b above.) 

 
The source code for a work means the preferred form of the work for making modifications to it.  
For an executable work, complete source code means all the source code for all modules it contains, 
plus any associated interface definition files, plus the scripts used to control compilation and 
installation of the executable.  However, as a special exception, the source code distributed need not 
include anything that is normally distributed (in either source or binary form) with the major 
components (compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable. 
 
If distribution of executable or object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place counts as 
distribution of the source code, even though third parties are not compelled to copy the source along 
with the object code. 
 
  4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided 
under this License.  Any attempt otherwise to copy, modify, sublicense or distribute the Program is 
void, and will automatically terminate your rights under this License. However, parties who have 
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received copies, or rights, from you under this License will not have their licenses terminated so 
long as such parties remain in full compliance. 
 
  5. You are not required to accept this License, since you have not signed it.  However, nothing else 
grants you permission to modify or distribute the Program or its derivative works.  These actions 
are prohibited by law if you do not accept this License.  Therefore, by modifying or distributing the 
Program (or any work based on the Program), you indicate your acceptance of this License to do so, 
and all its terms and conditions for copying, distributing or modifying the Program or works based 
on it. 
 
  6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the Program 
subject to these terms and conditions.  You may not impose any further restrictions on the 
recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance 
by third parties to this License. 
 
  7. If, as a consequence of a court judgment or allegation of patent infringement or for any other 
reason (not limited to patent issues), conditions are imposed on you (whether by court order, 
agreement or otherwise) that contradict the conditions of this License, they do not excuse you from 
the conditions of this License.  If you cannot distribute so as to satisfy simultaneously your 
obligations under this License and any other pertinent obligations, then as a consequence you may 
not distribute the Program at all.  For example, if a patent license would not permit royalty-free 
redistribution of the Program by all those who receive copies directly or indirectly through you, 
then the only way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Program. 
 
If any portion of this section is held invalid or unenforceable under any particular circumstance, the 
balance of the section is intended to apply and the section as a whole is intended to apply in other 
circumstances. 
 
It is not the purpose of this section to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this section has the sole purpose of protecting the 
integrity of the free software distribution system, which is implemented by public license practices.  
Many people have made generous contributions to the wide range of software distributed through 
that system in reliance on consistent application of that system; it is up to the author/donor to decide 
if he or she is willing to distribute software through any other system and a licensee cannot impose 
that choice. 
 
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of 
this License. 
 
  8. If the distribution and/or use of the Program is restricted in certain countries either by patents or 
by copyrighted interfaces, the original copyright holder who places the Program under this License 
may add an explicit geographical distribution limitation excluding those countries, so that 
distribution is permitted only in or among countries not thus excluded.  In such case, this License 
incorporates the limitation as if written in the body of this License. 
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  9. The Free Software Foundation may publish revised and/or new versions of the General Public 
License from time to time.  Such new versions will be similar in spirit to the present version, but 
may differ in detail to address new problems or concerns. 
 
Each version is given a distinguishing version number.  If the Program specifies a version number 
of this License which applies to it and "any later version", you have the option of following the 
terms and conditions either of that version or of any later version published by the Free Software 
Foundation.  If the Program does not specify a version number of this License, you may choose any 
version ever published by the Free Software Foundation. 
 
  10. If you wish to incorporate parts of the Program into other free programs whose distribution 
conditions are different, write to the author to ask for permission.  For software which is 
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes 
make exceptions for this.  Our decision will be guided by the two goals of preserving the free status 
of all derivatives of our free software and of promoting the sharing and reuse of software generally. 
 
NO WARRANTY 
 
  11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR 
OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME 
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 
 
  12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE 
TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING 
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A 
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF 
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 
 
END OF TERMS AND CONDITIONS 
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GNU FREE DOCUMENTATION LICENSE 
 
Version 1.2, November 2002  
 
Copyright (C) 2000,2001,2002  Free Software Foundation, Inc. 
59 Temple Place, Suite 330, Boston, MA  02111-1307  USA 
Everyone is permitted to copy and distribute verbatim copies 
of this license document, but changing it is not allowed. 
 
0. PREAMBLE  
 
The purpose of this License is to make a manual, textbook, or other functional and useful document 
"free" in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, 
with or without modifying it, either commercially or noncommercially. Secondarily, this License 
preserves for the author and publisher a way to get credit for their work, while not being considered 
responsible for modifications made by others.  
 
This License is a kind of "copyleft", which means that derivative works of the document must 
themselves be free in the same sense. It complements the GNU General Public License, which is a 
copyleft license designed for free software.  
 
We have designed this License in order to use it for manuals for free software, because free 
software needs free documentation: a free program should come with manuals providing the same 
freedoms that the software does. But this License is not limited to software manuals; it can be used 
for any textual work, regardless of subject matter or whether it is published as a printed book. We 
recommend this License principally for works whose purpose is instruction or reference.  
 
1. APPLICABILITY AND DEFINITIONS  
 
This License applies to any manual or other work, in any medium, that contains a notice placed by 
the copyright holder saying it can be distributed under the terms of this License. Such a notice 
grants a world-wide, royalty-free license, unlimited in duration, to use that work under the 
conditions stated herein. The "Document", below, refers to any such manual or work. Any member 
of the public is a licensee, and is addressed as "you". You accept the license if you copy, modify or 
distribute the work in a way requiring permission under copyright law.  
 
A "Modified Version" of the Document means any work containing the Document or a portion of it, 
either copied verbatim, or with modifications and/or translated into another language.  
 
A "Secondary Section" is a named appendix or a front-matter section of the Document that deals 
exclusively with the relationship of the publishers or authors of the Document to the Document's 
overall subject (or to related matters) and contains nothing that could fall directly within that overall 
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not 
explain any mathematics.) The relationship could be a matter of historical connection with the 
subject or with related matters, or of legal, commercial, philosophical, ethical or political position 
regarding them.  
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The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those 
of Invariant Sections, in the notice that says that the Document is released under this License. If a 
section does not fit the above definition of Secondary then it is not allowed to be designated as 
Invariant. The Document may contain zero Invariant Sections. If the Document does not identify 
any Invariant Sections then there are none.  
 
The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-
Cover Texts, in the notice that says that the Document is released under this License. A Front-Cover 
Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.  
 
A "Transparent" copy of the Document means a machine-readable copy, represented in a format 
whose specification is available to the general public, that is suitable for revising the document 
straightforwardly with generic text editors or (for images composed of pixels) generic paint 
programs or (for drawings) some widely available drawing editor, and that is suitable for input to 
text formatters or for automatic translation to a variety of formats suitable for input to text 
formatters. A copy made in an otherwise Transparent file format whose markup, or absence of 
markup, has been arranged to thwart or discourage subsequent modification by readers is not 
Transparent. An image format is not Transparent if used for any substantial amount of text. A copy 
that is not "Transparent" is called "Opaque".  
 
Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo 
input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-
conforming simple HTML, PostScript or PDF designed for human modification. Examples of 
transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary formats 
that can be read and edited only by proprietary word processors, SGML or XML for which the DTD 
and/or processing tools are not generally available, and the machine-generated HTML, PostScript or 
PDF produced by some word processors for output purposes only.  
 
The "Title Page" means, for a printed book, the title page itself, plus such following pages as are 
needed to hold, legibly, the material this License requires to appear in the title page. For works in 
formats which do not have any title page as such, "Title Page" means the text near the most 
prominent appearance of the work's title, preceding the beginning of the body of the text.  
 
A section "Entitled XYZ" means a named subunit of the Document whose title either is precisely 
XYZ or contains XYZ in parentheses following text that translates XYZ in another language. (Here 
XYZ stands for a specific section name mentioned below, such as "Acknowledgements", 
"Dedications", "Endorsements", or "History".) To "Preserve the Title" of such a section when you 
modify the Document means that it remains a section "Entitled XYZ" according to this definition.  
 
The Document may include Warranty Disclaimers next to the notice which states that this License 
applies to the Document. These Warranty Disclaimers are considered to be included by reference in 
this License, but only as regards disclaiming warranties: any other implication that these Warranty 
Disclaimers may have is void and has no effect on the meaning of this License.  
 
2. VERBATIM COPYING  
 
You may copy and distribute the Document in any medium, either commercially or 
noncommercially, provided that this License, the copyright notices, and the license notice saying 
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this License applies to the Document are reproduced in all copies, and that you add no other 
conditions whatsoever to those of this License. You may not use technical measures to obstruct or 
control the reading or further copying of the copies you make or distribute. However, you may 
accept compensation in exchange for copies. If you distribute a large enough number of copies you 
must also follow the conditions in section 3.  
 
You may also lend copies, under the same conditions stated above, and you may publicly display 
copies.  
 
3. COPYING IN QUANTITY  
 
If you publish printed copies (or copies in media that commonly have printed covers) of the 
Document, numbering more than 100, and the Document's license notice requires Cover Texts, you 
must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover 
Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly 
and legibly identify you as the publisher of these copies. The front cover must present the full title 
with all words of the title equally prominent and visible. You may add other material on the covers 
in addition. Copying with changes limited to the covers, as long as they preserve the title of the 
Document and satisfy these conditions, can be treated as verbatim copying in other respects.  
 
If the required texts for either cover are too voluminous to fit legibly, you should put the first ones 
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.  
 
If you publish or distribute Opaque copies of the Document numbering more than 100, you must 
either include a machine-readable Transparent copy along with each Opaque copy, or state in or 
with each Opaque copy a computer-network location from which the general network-using public 
has access to download using public-standard network protocols a complete Transparent copy of the 
Document, free of added material. If you use the latter option, you must take reasonably prudent 
steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent 
copy will remain thus accessible at the stated location until at least one year after the last time you 
distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.  
 
It is requested, but not required, that you contact the authors of the Document well before 
redistributing any large number of copies, to give them a chance to provide you with an updated 
version of the Document.  
 
4. MODIFICATIONS  
 
You may copy and distribute a Modified Version of the Document under the conditions of sections 
2 and 3 above, provided that you release the Modified Version under precisely this License, with 
the Modified Version filling the role of the Document, thus licensing distribution and modification 
of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in 
the Modified Version:  
 
 
A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and 
from those of previous versions (which should, if there were any, be listed in the History section of 
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the Document). You may use the same title as a previous version if the original publisher of that 
version gives permission.  
B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of 
the modifications in the Modified Version, together with at least five of the principal authors of the 
Document (all of its principal authors, if it has fewer than five), unless they release you from this 
requirement.  
C. State on the Title page the name of the publisher of the Modified Version, as the publisher.  
D. Preserve all the copyright notices of the Document.  
E. Add an appropriate copyright notice for your modifications adjacent to the other copyright 
notices.  
F. Include, immediately after the copyright notices, a license notice giving the public permission to 
use the Modified Version under the terms of this License, in the form shown in the Addendum 
below.  
G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given 
in the Document's license notice.  
H. Include an unaltered copy of this License.  
I. Preserve the section Entitled "History", Preserve its Title, and add to it an item stating at least the 
title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is 
no section Entitled "History" in the Document, create one stating the title, year, authors, and 
publisher of the Document as given on its Title Page, then add an item describing the Modified 
Version as stated in the previous sentence.  
J. Preserve the network location, if any, given in the Document for public access to a Transparent 
copy of the Document, and likewise the network locations given in the Document for previous 
versions it was based on. These may be placed in the "History" section. You may omit a network 
location for a work that was published at least four years before the Document itself, or if the 
original publisher of the version it refers to gives permission.  
K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of the 
section, and preserve in the section all the substance and tone of each of the contributor 
acknowledgements and/or dedications given therein.  
L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. 
Section numbers or the equivalent are not considered part of the section titles.  
M. Delete any section Entitled "Endorsements". Such a section may not be included in the Modified 
Version.  
N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in title with any 
Invariant Section.  
O. Preserve any Warranty Disclaimers.  
If the Modified Version includes new front-matter sections or appendices that qualify as Secondary 
Sections and contain no material copied from the Document, you may at your option designate 
some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections 
in the Modified Version's license notice. These titles must be distinct from any other section titles.  
 
You may add a section Entitled "Endorsements", provided it contains nothing but endorsements of 
your Modified Version by various parties--for example, statements of peer review or that the text 
has been approved by an organization as the authoritative definition of a standard.  
 
You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words 
as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one 
passage of Front-Cover Text and one of Back-Cover Text may be added by (or through 
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arrangements made by) any one entity. If the Document already includes a cover text for the same 
cover, previously added by you or by arrangement made by the same entity you are acting on behalf 
of, you may not add another; but you may replace the old one, on explicit permission from the 
previous publisher that added the old one.  
 
The author(s) and publisher(s) of the Document do not by this License give permission to use their 
names for publicity for or to assert or imply endorsement of any Modified Version.  
 
5. COMBINING DOCUMENTS  
 
You may combine the Document with other documents released under this License, under the terms 
defined in section 4 above for modified versions, provided that you include in the combination all 
of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant 
Sections of your combined work in its license notice, and that you preserve all their Warranty 
Disclaimers.  
 
The combined work need only contain one copy of this License, and multiple identical Invariant 
Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same 
name but different contents, make the title of each such section unique by adding at the end of it, in 
parentheses, the name of the original author or publisher of that section if known, or else a unique 
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license 
notice of the combined work.  
 
In the combination, you must combine any sections Entitled "History" in the various original 
documents, forming one section Entitled "History"; likewise combine any sections Entitled 
"Acknowledgements", and any sections Entitled "Dedications". You must delete all sections 
Entitled "Endorsements."  
 
6. COLLECTIONS OF DOCUMENTS  
 
You may make a collection consisting of the Document and other documents released under this 
License, and replace the individual copies of this License in the various documents with a single 
copy that is included in the collection, provided that you follow the rules of this License for 
verbatim copying of each of the documents in all other respects.  
 
You may extract a single document from such a collection, and distribute it individually under this 
License, provided you insert a copy of this License into the extracted document, and follow this 
License in all other respects regarding verbatim copying of that document.  
 
7. AGGREGATION WITH INDEPENDENT WORKS  
 
A compilation of the Document or its derivatives with other separate and independent documents or 
works, in or on a volume of a storage or distribution medium, is called an "aggregate" if the 
copyright resulting from the compilation is not used to limit the legal rights of the compilation's 
users beyond what the individual works permit. When the Document is included in an aggregate, 
this License does not apply to the other works in the aggregate which are not themselves derivative 
works of the Document.  
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If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the 
Document is less than one half of the entire aggregate, the Document's Cover Texts may be placed 
on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if 
the Document is in electronic form. Otherwise they must appear on printed covers that bracket the 
whole aggregate.  
 
8. TRANSLATION  
 
Translation is considered a kind of modification, so you may distribute translations of the 
Document under the terms of section 4. Replacing Invariant Sections with translations requires 
special permission from their copyright holders, but you may include translations of some or all 
Invariant Sections in addition to the original versions of these Invariant Sections. You may include 
a translation of this License, and all the license notices in the Document, and any Warranty 
Disclaimers, provided that you also include the original English version of this License and the 
original versions of those notices and disclaimers. In case of a disagreement between the translation 
and the original version of this License or a notice or disclaimer, the original version will prevail.  
 
If a section in the Document is Entitled "Acknowledgements", "Dedications", or "History", the 
requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual 
title.  
 
9. TERMINATION  
 
You may not copy, modify, sublicense, or distribute the Document except as expressly provided for 
under this License. Any other attempt to copy, modify, sublicense or distribute the Document is 
void, and will automatically terminate your rights under this License. However, parties who have 
received copies, or rights, from you under this License will not have their licenses terminated so 
long as such parties remain in full compliance.  
 
10. FUTURE REVISIONS OF THIS LICENSE  
 
The Free Software Foundation may publish new, revised versions of the GNU Free Documentation 
License from time to time. Such new versions will be similar in spirit to the present version, but 
may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.  
 
Each version of the License is given a distinguishing version number. If the Document specifies that 
a particular numbered version of this License "or any later version" applies to it, you have the 
option of following the terms and conditions either of that specified version or of any later version 
that has been published (not as a draft) by the Free Software Foundation. If the Document does not 
specify a version number of this License, you may choose any version ever published (not as a 
draft) by the Free Software Foundation.  
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